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LEGAL DISCLAIMER AND CONDITION OF USE 
This document contains information for the SHOUT ts/tw personal satellite tracking 

devices and accompanying accessories (“Product”), which are provided “as is.” Reasonable 

effort has been made to make the information in this document reliable and consistent with 

specifications, test measurements and other information. However, NAL Research 

Corporation and its affiliated companies, directors, officers, employees, agents, trustees or 

consultants (“NAL Research”) assume no responsibility for any typographical, technical, 

content or other inaccuracies in this document. NAL Research reserves the right in its sole 

discretion and without notice to you to change Product specifications and materials and/or 

revise this document or withdraw it at any time. User assumes the full risk of using the 

Product specifications and any other information provided. 

NAL Research makes no representations, guarantees, conditions or warranties, either 

express or implied, including without limitation, any implied representations, guarantees, 

conditions or warranties of merchantability and fitness for a particular purpose, non-

infringement, satisfactory quality, non-interference, accuracy of informational content, or 

arising from a course of dealing, law, usage, or trade practice, use, or related to the 

performance or nonperformance of any products, accessories, facilities or services or 

information except as expressly stated in this guide and/or the Product and/or satellite 

service documentation. Any other standards of performance, guarantees, conditions and 

warranties are hereby expressly excluded and disclaimed to the fullest extent permitted by 

the law. This disclaimer and exclusion shall apply even if the express limited warranty 

contained in this guide or such documentation fails of its essential purpose. 

In no event shall NAL Research be liable, whether in contract or tort or any other legal 

theory, including without limitation strict liability, gross negligence or negligence, for any 

damages in excess of the purchase price of the Product, including any direct, indirect, 

incidental, special or consequential damages of any kind, or loss of revenue or profits, loss 

of business, loss of privacy, loss of use, loss of time or inconvenience, loss of information or 

data, software or applications or other financial loss caused by the Product (including 

hardware, software and/or firmware) and/or the Iridium satellite, or arising out of or in 

connection with the ability or inability to use the Product (including hardware, software 

and/or firmware) and/or the Iridium satellite to the fullest extent these damages may be 

disclaimed by law and whether advised of the possibilities of such damages. NAL Research is 

not liable for any claim made by a third party or made by you for a third party. 
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ACRONYM LIST 
A-Hr .......................Amp-Hour 

ACL ........................Access-Control List 

AES ........................Advanced Encryption Standard 

BIS .........................Bureau of Industry and Security 

CE  .........................Conformité Européenne 

CEP ........................Circular Error Probability 

DISA ......................Defense Information Systems Agency 

DoD ........................Department of Defense 

EAR ........................Export Administration Regulations 

EMI ........................Electromagnetic Interference 

EMSS  .....................Enhanced Mobile Satellite Services 

FCC  .......................Federal Communications Commission 

FDMA ......................Frequency-division multiple access 

GMT .......................Greenwich Mean Time 

GNSS .....................Global Navigation Satellite System 

GPS ........................Global Positioning System 

HACC ......................Horizontal Accuracy 

HDOP .....................Horizontal Dilution of Precision 

IC  .........................Industry Canada 

IMEI  ......................International Mobile Equipment Identification 

LCD ........................Liquid-crystal display 

LED ........................Light-Emitting Diode 

Li-ion ......................Lithium-ion 

mA-Hr ....................milliAmp-Hour 

NDA .......................Non-Disclosure Agreement 

NOC .......................Network Operation Center 

OFAC ......................Office of Foreign Asset Controls 

PDOP ......................Position (3D) Dilution Of Precision 

PIN .........................Personal Identification Number 

PMS ........................PECOS Message Structure 

POP ........................Post Office Protocol 

RUDICS ..................Router-Based Unrestricted Digital Internetworking Connectivity 

Solution 

SBAS ......................Satellite-based Augmentation System 

SBD ........................Short-Burst Data 



  SHOUT ts/tw User Guide Version D 

Document Number: 451-92854-001D 10 of 65 

SMTP ......................Simple Mail Transfer Protocol 

TBR ........................Time-Between-Reports 

TDD........................Time-Division Duplex 

TDMA .....................Time-Division Multiple Access 

VDOP ......................Vertical Dilution Of Precision 

USB ........................Universal Serial Bus 

UTC ........................Coordinated Universal Time 



  SHOUT ts/tw User Guide Version D 

Document Number: 451-92854-001D 11 of 65 

1 INTRODUCTION 

In the SHOUT ts/tw User Guide, all references of the operational features, interface, and 

electrical specifications of the SHOUT ts device also apply to the SHOUT tw device. Where 

the SHOUT tw device differs from the SHOUT ts device, the user guide will note it in the 

applicable sections. The SHOUT tw device enclosure is IP67-rated and so is slightly larger 

and heavier. In addition, the SHOUT tw overlay membrane is larger than the SHOUT ts 

membrane, which seals around the display, power button and front panel LED (see Figure 

2). 

The SHOUT ts is a handheld satellite messaging and personal tracking device. It is 

designed to operate with the Iridium satellite network utilizing Short Burst Data (SBD). It 

can transmit location information determined by a highly sensitive Global Navigation 

Satellite System (GNSS) receiver, inbound and outbound status, text messaging, and 

emergency/alert notifications. 

The SHOUT ts significantly improves service reliability over existing tracking products by 

allowing two-way communication and confirmation of the nature of the distress to the first 

responder community. This reduces false alerts; helps identify the nature of the emergency 

so that the correct assets can be deployed, thereby reducing search and rescue costs; and 

provides communications feedback capability to the user to assist in rescue efforts. The 

SHOUT ts protocol is 100% compatible with the SHOUT, and SHOUT nano (when using the 

Iridium link). In this document, the terms SHOUT ts and ts are used interchangeably. 

The SHOUT ts is designed with ultra-low power consumption electronics drawing less 

than 110 μA during sleep. With an internal 1.95 A-Hr rechargeable Li-ion battery, depending 

on the environmental conditions, it can send a position report every ten minutes for more 

than ten days (more than 1,500 reports). Read Appendix C: Power Consumption to learn 

about the impact of blocked antennas on the number of reports. The SHOUT ts is equipped 

with a high-resolution color touchscreen and on-screen keyboards, allowing transmission of 

free-text, canned messages, and a combination of free-text and canned messages. The 

menu options are displayed as icons for quick access. The device can periodically wake up 

from sleep to send its position report to a command center. An Emergency 911 button is 

available for immediate emergency/alert notifications. Data are packaged in either standard 

or 256-bit Advanced Encryption Standard (AES) encrypted format. 

The SHOUT ts can send position reports and text messages in PECOS Message Structure 

(PMS). The PMS complies with the Blue Force Tracking Data Format Specification as defined 

in the document PECOS 200907-001 Version 1.7 [1]. The SHOUT ts is shipped without PMS 
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features activated and can only be enabled by NAL Research at the request of an authorized 

user. Functions related to PMS are described in Appendix A: PCOS Message Structure. 

The SHOUT ts offers a variety of services including: 

 Normal Tracking — The SHOUT ts can be programmed to automatically wake up 

and send a position report at a set interval ranging from once every minute to once 

every seven days (at one-minute increments). 

 Emergency Alert — Pushing the Emergency 911 button immediately sends alerts 

to a designated monitoring center(s). The home base and user can then 

communicate to define further specifics of the situation and a response to the 

emergency. 

 Free-Text Messaging — The SHOUT ts supports sending free-text via three 

different sets of touchscreen keyboards. 

 Canned Text Messaging — The SHOUT ts supports sending canned (predefined) 

messages stored in its memory. Sending canned messages saves bandwidth 

(effectively cost) because only short codes are transmitted to the server instead of 

the entire message body. 

 Waypoint Tracking — The SHOUT ts supports sending and/or saving waypoints for 

later retrieval. A waypoint is a GNSS location that you can identify and mark with a 

specific nametag for future reference. 

 Check-In — The SHOUT ts supports sending a quick check-in message using a 

single key. 

 Man Down — The SHOUT ts has an integrated motion sensor used to activate a 

man-down situation. 

 Geofencing — The SHOUT ts accepts multiple fences defined as polygons (50 

fences with up to 50 points each fence). The SHOUT ts can be activated based on 

conditions set by these fences. 

 Data Logger — The SHOUT ts has a circular buffer and can be programmed to 

store up to 4,000 positions for later retrieval. 

IMPORTANT: NAL Research can enable the SHOUT ts for use on the Iridium 

Department-of-Defense (DoD) Enhanced Mobile Satellite Services (EMSS) Gateway. 

However, accessing the EMSS Gateway is not authorized until the SHOUT ts is provisioned 

(signed up for airtime). Unauthorized attempts to access the EMSS Gateway will result in 

immediate disabling of the offending device, which must then be returned to NAL Research 

for repair. See webpage https://emss.pac.disa.mil/ for more information regarding DoD 

EMSS service provisioning. 

https://emss.pac.disa.mil/
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IMPORTANT: Do not disassemble the SHOUT ts for repair or services. The warranty is 

voided if the SHOUT ts is disassembled. Return it to NAL Research for services by calling 

NAL Tech Support (571-833-2169) or emailing Support@Nalresearch.com. 

 

mailto:Support@Nalresearch.com
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2 USING THE SHOUT TS 

2.1 DEVICE DESCRIPTION 

The SHOUT ts comprises a touchscreen, a power/back button, a status Light-Emitting 

Diode (LED), a guarded Emergency button, and a micro-B Universal Serial Bus (USB) port.  

 The touchscreen provides easy access to the device features. 

 The Power/Back button turns on the device and can be used as a back key.  

 The LED displays device status during emergencies and tracking. 

 The guarded emergency button activates a dedicated emergency message sequence 

until cancelled by the user. 

 The USB micro-B port is for charging, firmware updates, and setting parameters. 

Important: The SHOUT ts must have full view of the sky during transmission. 

 

Figure 1: SHOUT ts Exterior Components 

2.1.1 SHOUT TW IP67 RATING 

The SHOUT tw is IP67 rated. The IP67 rating provides the SHOUT tw with full protection 

against dust and other particulates, including a vacuum seal, and tested against continuous 

airflow. This protects the SHOUT tw against full immersion for up to 30 minutes at depths, 

between 15 cm and 1 meter (limited ingress permitted with no harmful effects). The SHOUT 

tw has a press-on port cover (IP67 rated) to seal the USB micro-B, while the Shout ts has a 

standard rubberized cover (see Figure 2). 

Guard 

Emergency Button 

Power/Back Button 

Iridium Antenna 

Touchscreen 

USB Micro-B 
Interface 

LED Status Display 

GNSS Antenna 
(embedded) 
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Figure 2: SHOUT ts/tw USB micro B Connector Cover Comparison 

2.2 ACCESSORIES 

The following accessories are included with the SHOUT ts. 

  

AC Wall Adapter USB-A to USB Micro-B cable 

Figure 3: SHOUT ts Accessories 

Manuals and software for the SHOUT ts may be found on the NAL website 

https://www.nalresearch.com/. 

SHOUT ts USB Micro B 

Connector Cover 

SHOUT tw USB Micro B 

Connector Cover 

https://www.nalresearch.com/
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2.3 CHARGING THE BATTERY 

The SHOUT ts ships with its internal lithium-ion battery partially charged. Fully charge 

the SHOUT ts before use. There are two (2) ways to charge the SHOUT ts: 

 Use the supplied AC wall adapter.  

o The charging time is approximately five (5) hours. 

 Connect to a standard USB device.  

o The charging time depends on the type of USB port.  

 USB 1.0 should be able to charge the SHOUT ts in about a day, assuming the 

port is capable of producing an output current of 100 mA.  

 USB 2.0 can charge in about 12 hours, assuming the current output of 0.5 A.  

NAL Research offers 12 VDC and 28 VDC chargers sold as separate items. 

 

The ts has a battery symbol    at the top-right corner of its screen indicating the 

battery is being charged. A message appears when charging is complete. The device can be 

safely operated and does not need to be turned off while charging. The charging cycle 

completes quicker when the device is turned off. While using the SHOUT ts, the battery 

symbol turns red when the remaining power is less than 20%. A warning message appears 

when the remaining power is less than 10%. 

Important: The SHOUT ts must be kept in environments between 0°C (32°F) and 45°C 

(113°F) when charging. 

2.4 TOUCHSCREEN 

The SHOUT ts has a resistive touchscreen. Use either a finger or a stylus to select 

options displayed on the screen. Resistive touchscreens offer consistent and durable 

WARNING! 

All batteries can cause property damage, injury, or burns if a conductive 

material, such as jewelry or keys, touches exposed terminals. The material 

may complete an electrical circuit and become extremely hot. To protect 

against such unwanted current drain, exercise care in handling any charged 

battery, particularly when placing it inside your pocket, purse, or other 

container with metal objects. 

Do not disassemble the SHOUT ts for battery replacement. Return it to NAL 

Research for services. Risk of explosion if battery is replaced with an 

incorrect type. Dispose of the batteries (ts) according to local, state, and 

federal regulations or laws. 
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performance in harsh environments. However, as with any touchscreen devices, be careful 

not to damage it with a sharp object. Unlike a capacitive touchscreen on most cellular 

phones where a slight tap of the finger is required, a resistive touchscreen requires a more 

moderate finger pressure. Resistive touchscreens drift slowly over time and need to be 

recalibrated periodically. To do this, open the Setting > Calibrate menu. 

 

Figure 4: Resistive Touchscreen 

2.5 BASIC NAVIGATION 

 Turn on the SHOUT ts by holding down the Power/Back button for approximately 

two seconds. 

Note: A delay in displaying time and date is normal because the unit first has to 

check its internal clock against the GNSS receiver.  

 Once the device is on, touch any icon to access device features. 

Note: Remember to apply moderate pressure with a fingertip. Resistive screens 

require a little more than a slight touch.  

 Press the Back button at any time to return to the previous screen. 

 Frequently used icons can be configured to appear on the bottom of the Home menu 

using Settings > Favorites. 

 Turn off the SHOUT ts (completely off with no tracking or text messaging) at any 

time by holding down the Power/Back button for approximately two seconds.  

 The device automatically “goes to sleep” after 90 seconds of inactivity. 

Either a stylus or gloved 
finger can be used to access 
features on the resistive 
touchscreen 

http://www.google.com/imgres?q=gloves&hl=en&safe=off&biw=1205&bih=647&gbv=2&tbm=isch&tbnid=h3dLUjg3VlqjSM:&imgrefurl=http://www.bigleaguestore.com/akadema-baseball-batting-gloves-c-68_32.html?sort%3D2d%26page%3D1&docid=8XIsvk4AYZzzUM&imgurl=http://www.bigleaguestore.com/images/batting-gloves-grey-red.jpg&w=400&h=400&ei=ef6XT9GgAsTV0QHUwOG7Bg&zoom=1&iact=hc&vpx=477&vpy=2&dur=135&hovh=225&hovw=225&tx=122&ty=83&sig=106668968113636696585&page=4&tbnh=146&tbnw=146&start=69&ndsp=24&ved=1t:429,r:20,s:69,i:334
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2.6 USING THE KEYBOARDS 

Some options require the use of on-screen keyboards to enter information. Three 

different keyboards are available in landscape orientation—lower case, upper case, and 

number/special characters. Switch between keyboards with special designated keys next to 

the Done key. The keyboard screen is divided into three (3) sections as shown in Figure 5 

below: (1) header bar, (2) text box, and (3) keyboard. 

The number displayed on the far right-hand side of the header bar indicates the 

remaining allowable number of characters that can be entered into the text box. 

 

Figure 5: Keyboard Screen 

Use the keyboards to enter text inside the text box. The recommended hand-position is 

shown in Figure 6 below utilizing two thumbs to tap the keyboard. While entering text, the 

position of the cursor in the text box is shown as a flashing white block. The block turns red 

when the maximum limit is reached (Remaining: 0). An alert sounds when the maximum 

number of characters is exceeded and additional text is entered. 

You can hold down any key while sliding around the keyboard. The key is not entered 

until the finger is lifted. The entire text box can be erased with the Clear button. Unclear 

reverses the process. Tap Done to accept entered text and return to the previous screen. 

Press the back key   to return to the previous screen without all the changes—all the 

changes will be lost. 

Keyboard 

Text Box 

Header bar 

 Cursor (flashing) 
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Figure 6: Keyboard Hand-position 

Edit entered text by tapping anywhere inside the text box. It is much easier to use a 

fingernail or a stylus to accurately position the cursor over the character to be edited. 

Holding and sliding a finger inside the text box prompts the device to display a segment of 

the text in the header bar, as shown in Figure 7 below. The position of the cursor is 

displayed in red character. A space and enter key appear as    and  , respectively. 

 

Figure 7: Hold and Slide on Keyboard 

 

 

 

 

 

 

 

Finger position 

highlighted in 

red character 
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2.7 USING THE SEARCH BOX 

Some menu options have a Search box to search for specific keywords or phrases. The 

search parameters are defined using Settings > Search menu. Touching the Search box 

opens a keyboard to enter the search item. 

 

Figure 8: Search Box 

2.8 USING THE SLIDER BAR 

For menus with options longer than the screen can display, a slider bar appears on the 

right-hand side. Hold and drag the slider with a fingertip to quickly scroll the list. A slight 

finger movement either up or down makes the SHOUT ts scroll one line at a time. Tapping 

above the slider prompts the screen to page up and tapping below the slider prompts the 

screen to page down. The active area or detection region of the slider bar is wider than the 

slider bar itself. Thus, it is possible to place a finger slightly away from the right edge of the 

screen to give a more comfortable feel. 

Search Box 
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Figure 9: Slider Bar 

2.9 NETWORK OPERATION CENTER (NOC) 

The SHOUT ts comprises an Iridium 9602 transceiver module capable of Short-Burst 

Data (SBD) connectivity to the Iridium satellite network. As a messaging and tracking 

device, its function is to send GNSS reports and text messages to a Network Operation 

Center (NOC). While deployed in the field, the SHOUT ts can also accept real-time text 

messages and commands from a NOC. For Iridium services, the SHOUT ts can be 

provisioned by NAL Research or any certified Iridium airtime service provider, including DoD 

Defense Information Systems Agency (DISA) EMSS office. 

A NOC can be a sophisticated central monitoring center equipped with servers connected 

to high-speed networks. A NOC can also be as simple as a handheld mobile device, a laptop, 

or a desktop attached to the Internet, to an Iridium transceiver, or to any wireless network. 

A NOC is required to receive and implement the logic necessary for analyzing the SHOUT ts 

messages and determine the appropriate response. 

2.10 SERVER FOR TRACKERS SOFTWARE 

Upon request, NAL Research provides Server for Trackers software, which you can install 

on your NOC to retrieve NAL Research’s formatted GPS reports from the remote SHOUT ts. 

In addition, the program lets a NOC communicate with modems attached to its serial ports, 

communicate with Post Office Protocol (POP3)/ Simple Mail Transfer Protocol (SMTP) 

 Either slide to quickly scroll up and down 
 or tap to page up and down 
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servers, communicate with Iridium SBD DirectIP servers, and/or act as a Router-Based 

Unrestricted Digital Internetworking Connectivity Solution (RUDICS) server/client to support 

incoming and outgoing communications with the SHOUT ts. Under special cases and with a 

signed Non-Disclosure Agreement (NDA), NAL Research will release our proprietary GPS 

report formats for developers to implement into their own tracking software. 

2.11 SATTERM SOFTWARE 

Use the included SatTerm software to set up the SHOUT ts operating parameters, 

geofences, contacts, and canned messages. For instructions on how to configure the device 

using the SatTerm Software, refer to the “SatTerm for SHOUT ts Manual” [3]. Most of the 

operating parameters can be set using the SHOUT ts on-screen menus. However, more 

sophisticated features such as encryption and geofence must be carried out via SatTerm 

and a computer connected to the SHOUT ts. For contacts and canned messages, the SHOUT 

ts sends only short codes instead of the message body to a NOC server. Short codes are 

then mapped to the real addresses and/or canned messages with a lookup table saved on 

the NOC server during setup. Therefore, when SatTerm is used to enter contacts and 

canned messages, SatTerm synchronizes short codes between the SHOUT ts and the NOC 

server. Email addresses, on the other hand, can be entered on the fly. 

2.12 MAPPING NOC SERVER 

NAL Research provides a mapping NOC server to our customers for demonstration 

purposes ONLY. Application developers can call for instructions to set up a free demo 

account. NAL Research’s NOC server implements Google Earth to display tracking 

information. NAL Research assumes no responsibility for any claims or damages arising out 

of the use of our server. NAL Research makes no warranties on the performance or the 

availability of our server. 
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3 HOME SCREEN 

1. Immediately after turning on, press the unlock bar located at the bottom of the 

screen.  

Note: A delay in displaying time and date is normal because the unit has to check 

its internal clock against the GNSS receiver.  

2. Enter a Personal Identification Number (PIN), if the device is set up with password 

protection.  

Note: NAL Research ships the SHOUT ts without password protection. However, if 

the PIN is factory-set, it should be 1111. 

The Home screen appears. Device status symbols are displayed along the top three 

lines of the home screen. Some symbols do not appear until an event is initiated, 

such as sending or receiving a message. 

 

Figure 10: Home Screen 
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3.1 STATUS SYMBOLS 

Table 1: Status Symbols 

 

Denotes the Iridium transceiver is off. To preserve battery life, the Iridium 

transceiver is only turned on when transmitting a message or position report; 

thus, a diagonal line is drawn over the symbol when off. 

 

Denotes either: (1) the Iridium transceiver is on with real-time signal strength 

represented by the number of vertical bars or (2) SBD message transmission 

is in progress. The signal strength can range from the lowest of zero to the 

highest of five bars. During transmission, the antenna must have a clear view 

of the sky. The SHOUT ts cannot send messages or reports from inside a 

building. 

 
Denotes the GNSS receiver is off. The GNSS receiver is always kept off to 

preserve battery life until time, date, or position information is needed. 

 

Denotes the GNSS receiver is on with real-time satellite acquisition status 

represented by the number of vertical bars.  

 One bar represents valid time and date fix.  

 Two bars represent 2D fix or dead reckoning. 

 Three bars represent 3D fix with HDOP higher than 2.0.  

 Four bars represent 3D fix with HDOP less than 2.0.  

Although the SHOUT ts’ GNSS receiver can often obtain a location fix when 

the antenna is partially blocked (near buildings, in a room next to a window, 

etc.), the antenna must have a clear view of the sky to minimize acquisition 

time, provide better position accuracy, and reduce power consumption. 

 Battery indicator. 

 Denotes the battery is being charged by an external power source. 

 
Denotes all audio alerts are off. 

 
Denotes audio alert is on. 

 Denotes one or more unread messages are in the Inbox. 

 
Denotes one or more messages are in the Outbox ready to be sent or one or 

more messages in queue failed to send. 

 

Denotes Geofences is on when the symbol is bright white. The symbol turns 

dimmed gray when geofence tracking is off. The geofence symbol does not 

appear when there are no fences saved into the device. 

 

Denotes Call Out is on when the symbol is bright white. The symbol turns 

dimmed gray when Call Out is off. The Call Out symbol does not appear when 

there are no Call Out times saved into the device. 
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Table 1: Status Symbols 

 
Denotes Mailbox Check is on when the symbol is bright white. The symbol 

turns dimmed gray when Mbox Check is off. 

 

Denotes tracking (standard tracking, geofence tracking, etc.) is on when the 

symbol is bright white. When standard tracking is on, a countdown timer to 

the next report appears beside the tracking symbol. The symbol turns dimmed 

gray when tracking is off. 

 

Denotes Man Down is on. 

 

3.2 DATE/TIME 

The current date and time are displayed in formats set by the Settings > Time > Date 

option. The GNSS receiver has an internal clock; as long as the battery is not depleted and 

a valid position fix was previously acquired, the SHOUT ts can recall the correct date and 

time. The message “Date/Time unavailable” is displayed when the SHOUT ts is unable to 

restore information from the GNSS receiver. 

3.3 HOME ICONS 

The SHOUT ts displays four (4) main icons on its home screen, each representing a 

menu option—Texting Menu, Tracking Menu, Utilities Menu, and Settings Menu. 

Detailed descriptions of each of these menu options are included in the next section. 

3.4 FAVORITE ICONS 

The bottom of home screen has a favorites bar to provide quick and easy access to the 

most frequently used options. You can configure any of the menu icons to appear on the 

favorites bar using Settings > Favorites. A maximum of four favorite icons is allowed. The 

icons appear in the order of selection from left to right. 
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4 QUICK START 

Airtime services must first be purchased for Iridium before use. Purchase Iridium airtime 

directly from NAL Research or from any of Iridium certified airtime resellers. Reading the 

entire manual is helpful to learn how to operate the SHOUT ts as a messaging device. As a 

tracking device, you can quickly set up the SHOUT ts with just a few simple steps shown 

below. However, a server is required to receive tracking reports. 

1. Turn on the SHOUT ts by holding down the power/back button   for about two 

seconds. 

2. Go to the Tracking > Format menu  to set the report format. 

3. Go to the Tracking > Rpt Rate menu  to set the reporting rate and turn 

tracking on. The SHOUT ts is now in tracking mode and ready to send position 

reports. No further action is required. The unit automatically goes to “sleep” in 

between reports. 

IMPORTANT: NAL Research can enable the SHOUT ts for use on the Iridium DoD EMSS 

Gateway. However, accessing the EMSS Gateway is not authorized until the SHOUT ts is 

provisioned (signed up for airtime). Unauthorized attempts to access the EMSS Gateway will 

result in immediate disabling of the offending device, which must then be returned to NAL 

Research for repair. See webpage https://sbd.pac.disa.mil for more information regarding 

DoD EMSS service provisioning. 

https://sbd.pac.disa.mil/
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5 TEXTING MENU 

Use the Texting menu to compose, save, view, and send canned or free-text 

messages, check the mailbox for incoming messages, and set up an automatic 

mailbox check frequency. 

 

Figure 11: Texting Menu 

5.1 INBOX 

The Inbox folder contains all incoming read and unread messages with the newest 

at the top of the list. Read messages have a white opened envelope symbol  next 

to them. Unread messages have a green closed envelope symbol. A closed envelope symbol 

 appears at the top of the screen when an unread message(s) is in the Inbox. Go to the 

Settings > Audio menu to enable the speaker, which provides an audible alert for all new 

incoming messages. 

5.2 DRAFTS 

The Drafts folder contains draft messages saved under the Compose menu. The 

SHOUT ts stores the newest message at the top and the oldest message at the 

bottom of the list.  

1. Select a draft message to open the Compose screen.  

2. Select Send.  
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A Confirm and then a Success box appear to indicate that the message has been 

added to the Outbox.  

Note: If the Inc GPS option is enabled, then GNSS location will be attached to the 

message. Messages with GNSS location attached can take longer to complete 

because the SHOUT ts has to acquire a GNSS position. 

5.3 OUTBOX 

The Outbox folder contains either messages waiting to be sent or messages that 

failed to send. A message in the process of being sent is marked with a << symbol. A 

message that failed to send has a red X symbol. A message in queue waiting to be sent has 

no symbol. For each message queued in the Outbox waiting to be sent, the SHOUT ts has a 

two-minute window to transmit. Then the message will be dequeued to avoid draining the 

battery.  

Messages that failed to send remain in the Outbox sorted in the order of priority and 

then by the oldest to the newest messages. The symbol    appears at the top of the 

screen when there is a queued or dequeued message(s) in the Outbox. 

Failed messages can be deleted or resent (enqueue). However, if you resend a failed 

message and if the failed message is successfully retransmitted, the SHOUT ts automatically 

attempts to resend as many remaining failed messages in the Outbox as possible in the 

following order of priority. 

Category 1 (highest priority): 

Callout 

Cancel Emergency 

Geofence Arrive/Depart 

Man Down 

Category 2: 

Check-In 

Queued Tracking Report 

Category 3: 

Motion Start/End Report 

Statistics Report 

Test Report 

Category 4 (lowest priority): 

Remote Update Response 

Poll Report 

Text Message  

Waypoint 

If there are multiple items in the same category, the oldest will be sent first. The SHOUT 

ts automatically resends failed messages in the order stated above after a successful 

transmission (by accessing the network through methods such as Tracking, Test Report, 
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Waypoint, etc.). To avoid draining the battery, maintain the Outbox frequently and delete 

unwanted failed reports. 

5.4 SENT 

The Sent folder contains messages successfully sent to a NOC server. A message 

can be resent, forwarded, or deleted.  

 Resend moves a message to the bottom of the Outbox folder’s sending queue.  

 Forward opens the Compose menu to enter additional information. You can then 

resend the message after modifying it or cancel the process.  

 Delete permanently removes the message from the Sent folder.  

The SHOUT ts stores messages in the Sent folder with the newest message displayed at 

the top of the list. 

5.5 COMPOSE 

The Compose menu provides options to enter, edit, and send canned messages, 

free-text messages, or a combination of canned and free-text messages to: (1) a 

NOC server, (2) a predefined list of email addresses, and/or (3) any email addresses 

entered via the keyboards. 

The SatTerm software creates and saves predefined email addresses onto the SHOUT ts’ 

contact list. During setup, SatTerm requires connectivity between the SHOUT ts and a NOC 

server to synchronize the lookup table of short codes. As with canned messages, short 

codes map the actual email addresses to a lookup table located at a NOC. 

To compose a message: 

1. Select the Compose menu.  

A screen appears with two distinct regions: “To: Server” and “Canned Message.”  

2. Hold a finger inside the To: Server region.  

The SHOUT ts displays two options, Choose Contacts and Enter Emails, as shown in 

Figure 12 below. 
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Figure 12: Choose Contacts or Enter Emails 

o You can slide a finger back and forth between these two options.  

o Remember to apply moderate pressure on the touchscreen while sliding the 

finger. DO NOT lift the finger until the right choice is selected.  

o Sliding the finger away to the top of the screen or bottom of the screen cancels 

this option. 

3. Choose Contacts 

a. If Choose Contacts is selected and if contacts were entered with SatTerm, a list 

of contacts appears in alphabetical order.  

b. Select a single contact or multiple contacts in the list and tap Add to accept.  

c. Remove a contact by going back to Choose Contact, unselecting the contact 

checkbox, and tapping Add.  

Note: Pressing the back key instead of Add after selecting or clearing a contact 

checkbox cancels the choice(s). 



  SHOUT ts/tw User Guide Version D 

Document Number: 451-92854-001D 31 of 65 

 

Figure 13: Choose Contacts 

4. Enter Emails 

a. If Enter Emails is selected, a keyboard appears.  

b. Multiple email addresses can be entered, separated by a comma.  

Note: All email addresses, including the commas, must be a total of 255 

characters or less. The SHOUT ts keeps track of the limit and prevents entering 

email addresses longer than allowed. Email addresses and free-text messages 

share the same memory space with a maximum allowable length of 309 

characters. Long email addresses and multiple email addresses reduce the 

number of characters available for a free-text message.  

Note: The SHOUT ts sends short codes representing the contacts listed under 

To; however, the SHOUT ts sends the actual email addresses listed under 

Emails. Any email addresses entered under Enter Emails can be removed by 

going back to the keyboard under the Enter Emails pop-up menu. 

5. Hold a finger inside the Canned Message region to view two options—Choose Can’d 

Msg and Enter Text.  
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Figure 14: Choose Can'd Msg and Enter Text Options 

6. Can’d Msg 

a. If Choose Can’d Msg is selected and if canned messages were entered with 

SatTerm, a list of canned messages appears in the order they were entered with 

SatTerm.  

 

Figure 15: Select a Canned Message 

b. Tap a canned message to view the complete canned message. 

c. Tap Select to choose the message.  

d. Hold a finger inside the Canned Message region to view the Remove Can’d Msg 

option.  



  SHOUT ts/tw User Guide Version D 

Document Number: 451-92854-001D 33 of 65 

e. Select Remove Can’d Msg to remove the selected canned message at any 

time, even after free-text has been entered. 

Note: As with the contact list, SatTerm is used to create and save canned 

messages into the SHOUT ts’ memory. During setup, SatTerm requires 

connectivity between the SHOUT ts and a NOC server to synchronize the lookup 

table of short codes. Sending canned messages saves bandwidth and airtime 

cost because only short codes are being transmitted instead of the entire 

message body. The short codes are defined by application developers and not by 

the SHOUT ts. 

7. Enter Text. 

a. Use the Enter Text option to create free-text messages with three on-screen 

keyboards (see the Using the Keyboards section). If a canned message is 

previously selected, then the entered free-text is appended to the canned 

message. 

8. Send the message or save as a draft.  

a. If Send is selected, a Success screen appears to indicate that the message has 

been added to the Outbox. Hold the SHOUT ts with the antennas having full view 

of the sky if using the Iridium link.  

i. If the Inc GPS option is turned on, then GNSS location will be added to the 

message. Messages with GNSS location takes longer to complete because 

the SHOUT ts has to acquire a GNSS fix. 

5.6 CONTACTS 

Contacts is an address book with a list of contacts created and saved into the SHOUT ts’ 

memory using NAL Research’s SatTerm software. During setup, SatTerm requires 

connectivity between the SHOUT ts and a NOC server to synchronize the lookup table of 

short codes. As with canned messages, short codes are used to map real addresses to a 

lookup table located at a NOC. 

Each contact is stored in a five-line format. The first line can have up to 30 characters, 

the second can have 30 characters, the third can have 50 characters, the fourth can have 

30 characters, and the fifth can have 30 characters. The information contained in each line 

is defined by developers and not by the SHOUT ts. 

Figure 16 below displays an example of the formatted contact defined by the NAL 

Research’s NOC server. The first line has the contact name, the second line has the group 
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name, the third line has the email address, the fourth line has the phone number, and the 

fifth line has the home address. 

You can assign contacts to specific groups to organize the address book. The group field 

arranges the contacts based on the group name, in alphabetical order. The groups are first 

sorted by alphabetical order. Following that, the contacts are then sorting inside each group 

in the same manner. If there are contacts that do not contain a group, they are sorted 

above of the list of groups alphabetically. Tap on a group header to expand and condense 

each of the groups for better viewing. 

Upon receiving a free-text or canned message from the SHOUT ts that is referenced to a 

specific contact, the NAL Research’s NOC server forwards the message to the email address 

listed on the second line of the contact. Application developers can define their own set of 

rules with information contained in the contact so that their NOC servers can use them to 

determine the appropriate response. 

 

 

 

Figure 16: Formatted Contact 

5.7 CHK MBOX 

The Check Mailbox [Chk Mbox] option is available ONLY when the Iridium link is 

enabled.  

There are three ways the SHOUT ts can initiate a mailbox check for any pending 

messages at the Iridium gateway: 

1. Manually force the SHOUT ts to check the mailbox at any time using the Chk Mbox 

menu. 
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2. When tracking mode is enabled, the SHOUT ts automatically checks the mailbox 

each time it wakes up to send a position report. 

3. Using the Mbox Rate menu (see below for detailed description), the SHOUT ts can 

be set to automatically wake up and check the mailbox at a preset frequency. A 

position report will not be sent when the SHOUT ts wakes up to check the mailbox 

unless the mailbox check rate coincides with the tracking report rate. 

The Check Mailbox menu can either be in Idle or Checking the Iridium gateway for any 

pending messages to be downloaded. As the messages are being downloaded, the SHOUT ts 

shows the number of unread messages in the Inbox and the number of messages still 

queued at the Iridium gateway to be downloaded. 

5.8 MBOX RATE 

The Mailbox Rate [Mbox Rate] option is available ONLY when the Iridium link is 

enabled.  

The Mbox Rate is used to set mailbox check rate (time between mailbox checks) and to 

enable mailbox check automatically. Select either a predefined rate or a user-defined rate 

with an on-screen keypad. The Mailbox Check Rate menu is dimmed when mailbox check is 

disabled. However, even when mailbox check is disabled and the labels are dimmed; you 

can still enter the rate. 

 

Figure 17: Mailbox Check Rate 

When mailbox check is enabled, the symbol    lights up from dimmed gray to bright 

white at the top of the screen. The SHOUT ts checks the Iridium gateway automatically for 

any pending messages at the next scheduled time. When mailbox check is enabled and the 

Labels are 
dimmed when 
mailbox check 

is disabled 

Enable/Disable 
mailbox check 

Mailbox 
check is 
enabled 
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SHOUT ts sleeps in between checks, the status LED flashes once every five seconds. The 

status LED can be turned off during sleep to reduce power consumption by using the 

Settings > LED menu. 

5.9 INC GPS 

The Include GPS [Inc GPS] option forces the SHOUT ts to attach GNSS location to 

Check-In and canned and free-text messages. Under default setting, these messages 

do not have GNSS information included. Messages with GNSS location attached can take 

longer to complete because the SHOUT ts has to acquire a GNSS fix first. Depending on the 

validity of the stored ephemeris data, it could take up to an additional 29 seconds. 

5.10 MEMORY 

Memory is used to clear messages in all mailboxes or clear messages in each 

individual box—Drafts, Inbox, Outbox, and Sent. 
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6 TRACKING MENU 

The Tracking menu for the SHOUT ts is shown below (see Figure 18). Some 

options are very complex, including Geofences and Call Out, which require SatTerm 

to set up. For these options, refer to the “SatTerm for SHOUT ts” manual [2]. 

 

Figure 18: Tracking Menu 

6.1 RPT RATE 

The Report Rate [Rpt Rate] is used to set the tracking report rate (time between 

tracking reports) and to enable tracking. You can set the reporting rate for standard 

or motion reporting through the two different tabs. Choose from either a predefined rate or 

a user-defined rate with an on-screen keypad. The Reporting Rate menu is dimmed for both 

tabs when tracking is disabled. However, even when tracking is disabled and the labels are 

dimmed; you can still enter the report rate. 

The On/Off buttons enable/disable the SHOUT ts tracking mode. When tracking is on, 

the tracking symbol at the top of the screen changes from dimmed gray to bright white. 

The SHOUT ts immediately turns the GNSS receiver on to acquire a GNSS fix and then 

attempts to transmit a position report. The next position report is sent automatically based 

on the reporting rate. The countdown timer to the next report is displayed inside the 

parentheses next to the tracking symbol. When tracking is enabled and the SHOUT ts sleeps 

in between position reports, the status LED   flashes once every five seconds. It can be 

turned off during sleep to reduce power consumption by using the Settings > LED menu. 
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Activate the Emergency 911 button at any time during tracking mode or non-tracking mode. 

The SHOUT ts can also be turned on at any time and used as a texting device. 

When waking up to transmit a location report and the Iridium link is used, the SHOUT ts 

antennas must have a full view of the sky; otherwise, it will fail to send. By default, a failed 

report will not be resent. Using the Q Rpt menu, failed reports can be forced to stay in the 

Outbox awaiting to be resent (see the Outbox section). 

The entire reporting duration can take up to two minutes depending on the Iridium 

satellite visibility and the validity of the GNSS ephemeris data. Ephemeris data saved on the 

GNSS receiver is valid for approximately two hours, allowing the receiver to obtain a hot-

start fix. Report rate (time between reports) set to more than two hours forces the GNSS 

receiver into either a warm-start or a cold-start fix (~29 seconds). As a result, the SHOUT 

ts consumes more battery power and the total number of reports is reduced. For more 

information, see Appendix C: Power Consumption. 

IMPORTANT: The SHOUT ts automatically resends all failed messages in the Outbox 

after a successful position report transmission. To avoid draining the battery unintentionally, 

carry out frequent maintenance on the Outbox and delete unwanted failed messages. 

The SHOUT ts logs and saves all position reports in its circular memory. When its 

memory is full, the oldest report is overwritten. SatTerm can be used to retrieve all position 

reports saved on the SHOUT ts. 

6.2 FORMAT 

The SHOUT ts can transmit position reports in either 30-byte or 10-byte format. 

Both of these formats are backward compatible with the SHOUT nano. 

The 30-byte format includes Coordinated Universal Time (UTC) date, UTC time, latitude, 

longitude, altitude, speed, course, vertical velocity, number of satellites used to obtain 3D 

fix, Horizontal Dilution of Precision (HDOP), and Vertical Dilution Of Precision (VDOP). 

Latitude and longitude are recorded with about 0.18 meters in resolution. 

The 10-byte format includes UTC time, latitude, longitude, and Position (3D) Dilution Of 

Precision (PDOP). With UTC date omitted, the SHOUT ts relies on the NOC server to stamp 

the date as the report arrives. Encryption is not available with the 10-byte format. Latitude 

and longitude are recorded with about 1.1 meters in resolution. The 10-byte format is 

selected strictly for the purpose of Iridium airtime cost saving. 

The SHOUT ts can also send position reports and text messages in PMS. The PMS 

complies with the Blue Force Tracking Data Format Specification. The SHOUT ts is shipped 
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without PMS features activated and can only be enabled by NAL Research at the request of 

an authorized user. Functions related to PMS can be found in Appendix A: PECOS 

Message Structure. 

6.3 LINK 

The SHOUT ts’ default setting is Yes to allow the Iridium link to be used to 

transmit reports and messages (see Figure 19). If the Iridium link is not allowed to 

be used (radio silence), set the Allowed setting to No. If Tracking is on, Data Logging is on, 

and Iridium link is set to No, tracking reports are saved in its circular memory. 

 

Figure 19: Iridium Link Allowed 

6.4 GEOFENCES 

In addition to “standard” tracking enabled through the Rpt Rate menu, Geofences 

is another tracking option tailored for specific applications. Geofence tracking works 

independently as a separate tracking mode or can be implemented along with standard 

tracking. Setting geofence parameters is complex. NAL Research recommends the use of 

both SatTerm and Google Maps®. You can also enter a sequence of latitude and longitude 

pairs to define a fence using just SatTerm. Refer to the “SatTerm for SHOUT ts” manual [2]. 

A geofence is a set of connected latitude and longitude coordinates that defines a region 

or zone of interest. A geofence must be bounded by a minimum of three coordinates and a 

maximum of 50. Each fence has a unique tracking profile that triggers the SHOUT ts to 

change its tracking behavior while inside a specific fence; e.g., it allows the SHOUT ts to 

turn off the Iridium link for regions that require radio silence. A geofence can be configured 
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to send special arrival/departure reports upon entering and/or exiting the fence (see Figure 

20). 

 

Figure 20: Geofences Enabled/Disabled 

The Geofences menu limits you to a just few options including: (1) browsing a list of 

fences loaded into the device through SatTerm, (2) viewing the map of each fence and its 

type of notification (arrival or departure), and (3) enabling/disabling a fence. Enter other 

geofence features through SatTerm. 

When a fence or fences are enabled, the Geofences symbol    at the top of the screen 

changes from dimmed gray to bright white (see Figure 21). The SHOUT ts immediately 

checks the GNSS receiver to determine whether the device is inside an enabled fence. If the 

SHOUT ts is inside an enabled fence, the Geofences symbol turns green and the fence label 

also turns green with the word Active attached to it. When a fence(s) is enabled and the 

SHOUT ts sleeps, the status LED    flashes once every five seconds. You can turn it off 

during sleep to reduce power consumption by using the Settings > LED menu. 

Enable/Disable 
a fence Enabled fences 

Labels are 
dimmed on 
fences that are 
disabled 
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Figure 21: Geofences Green When Active 

6.5 BREVITY 

The Brevity code is part of the PMS format. The SHOUT ts ignores the Brevity 

code settings, if the PMS/PECOS format is not activated and not selected. View 

functions related to Brevity code in Appendix A: PECOS Message Structure. 

6.6 MAN DOWN 

The Man Down option allows you to set the options used by the Man Down Alert 

feature. The Man Down Alert detects when the SHOUT ts is motionless for a 

configurable amount of time and triggers up to three (3) different alerts, if you do not 

respond affirmatively to an “Are You OK?” pop-up menu. After Man Down begins alerting, 

you can cancel it by selecting the Cancel 911 menu or selecting Off from the Man Down 

menu. The following settings are configurable through this menu: 

Time Down Duration — the amount of time the device must remain motionless before 

the “Are You OK?” menu displays. Whether the SHOUT ts is “Motionless” depends on a set 

of motion parameters configured using the SatTerm software. 

 

Active fence 

Symbol turns 
green when the 
device is inside 
an active fence 
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Figure 22: Man Down Options 

Count Down Duration — the amount of time for you to respond to the “Are You OK?” 

pop-up menu. If the countdown expires or you select No, the selected Man Down Alerts will 

trigger. 

Alerts — any combination of the following three alerts can be selected. 

Locator Alert Configurable audio alert that sounds until the Man Down Alert is 

disabled. You can set the alert type from the Audio menu. 

Start Emergency Starts emergency mode as if the red emergency button were 

pressed. 

Send Message Sends a text message with a Man Down short code and GNSS 

location information. 

6.7 CALL OUT 

The Call Out allows the SHOUT ts to send a scheduled daily tracking report at a 

defined Greenwich Mean Time (GMT) time using a specific link. Scheduled times are 

entered via SatTerm software and are listed under the Call Out menu. When a Call Out time 

is selected, the    symbol lights up from dimmed gray to bright white at the top of the 

screen. 

The Call Out option is useful when you need the device to transmit at a specific time 

and/or want to generate a daily heart beat message for each link. Refer to the “SatTerm for 

SHOUT ts” manual [2]. 

Symbol is shown 
when Man Down 
is enabled 
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6.8 Q RPT 

The SHOUT ts’ default setting is to discard all tracking reports that failed to 

transmit because of poor signal quality. Use Queue Report [Q Rpt] to force failed 

tracking reports to stay in the Outbox and wait to be resent at a later time. Refer to the 

Outbox section for a description of when failed tracking reports are resent. 

6.9 BLK RPT 

The SHOUT ts’ default setting is to send all tracking reports, even those with 

invalid GNSS position. Use Block Report [Blk Rpt] to configure the SHOUT ts to send 

only tracking reports with a valid GNSS position. 

6.10 DATA LOG 

The SHOUT ts’ default setting is to log and save all position reports in its circular 

memory. You can turn off this feature with the Data Log menu. When the SHOUT ts’ 

memory is full, the oldest reports are overwritten. You can use SatTerm to retrieve all 

position reports saved on the SHOUT ts. 

6.11 STATS 

The Stats menu has a countdown timer to the next report at the top of the screen 

and is replaced with Off when tracking is disabled. The bottom half of the screen 

displays the last successful report sent by tracking or emergency notification. Check-In, 

Way Point, free-text, and canned messages are not considered as “reports,” and therefore 

are not displayed even if a message was sent successfully. 

6.12 CANCEL 911 

After pressing the red emergency button    on the back of the SHOUT ts, you 

can deactivate the emergency alert by selecting the Cancel 911 option. The 

cancellation message is then queued in the Outbox to be transmitted. The emergency mode 

ends immediately. The emergency LED    is turned off and the top bar turns from red back 

to black. 

Turning the SHOUT ts off does not cancel the emergency mode. You MUST select the 

Cancel 911 option to cancel the emergency. 
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7 UTILITIES MENU 

The Utilities menu provides six (6) options used mainly to check for proper 

hardware operation and network setup. 

 

Figure 23: Utilities Menu 

7.1 CHK GPS 

The Check GPS [Chk GPS] option forces the SHOUT ts to turn on its GNSS 

receiver and to continuously update and display GNSS data in real-time. The GNSS 

receiver remains on until you leave this screen by pressing the back button. Use the Reset 

Ephemeris key to force the SHOUT ts to erase saved ephemeris in its memory and download 

a new set of ephemeris data. Be careful not to deplete the battery power by staying on this 

option for too long. 

Monitor the accuracy of the position by observing the Horizontal Accuracy (HACC). HACC 

is measured in meters. HACC is defined as the radius of a circle centered on the true value 

that contains the GNSS measurement. Thus, a position fix with ten meters’ HACC accuracy 

indicates that it is within ten meters of the true position—the higher the HACC value, the 

less accurate the GNSS measurement. 

The Check GPS option is a good indicator of whether or not the GNSS receiver has 

sufficient signal to initiate a Way Point or a Test Report when located in a challenging 

environment, e.g., in dense foliage or around urban settings with tall buildings. You can 

monitor HACC in real-time to ensure it converges to a small and stable value (usually less 

than 25 meters). At which point, it is certain that a 3D fix can be obtained with the most 

current ephemeris data being updated and saved. You can then go back to the Utilities 
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menu to send a test report. When the GNSS receiver cannot acquire a fix, HACC gradually 

increases and, at some point, stops at a value of 4294967.500. It is an indication that the 

surrounding obstructions prevent the GNSS receiver from obtaining a fix and you should 

move on to a different location. 

7.2 CHK IRIDIUM 

The Check Iridium [Chk Iridium] option forces the SHOUT ts to turn on its Iridium 

transceiver and continuously update and display signal strength in real-time. The 

Iridium transceiver remains on until you leave this screen by pressing the back button. Be 

careful not to deplete the battery power by staying on this option for too long. 

7.3 TEST RPT 

When the Test Report [Test Rpt] option is selected, the SHOUT ts immediately 

turns the GNSS receiver on to update its location data. The location information is 

continuously updated and displayed in real-time whether there is a valid fix or not. Similar 

to the Chk GPS option, you can monitor HACC to determine if a valid fix is possible. Once a 

valid fix is obtained, the GNSS receiver is turned off and the most recent 3D fix information 

is displayed on the screen. This information (called test report) can be forced to send to a 

NOC server by pressing Send. A test report has the same format as a regular position report 

and is treated as such by a NOC. Sending a test report does not disrupt or change the 

tracking reporting rate. 

The Test Rpt option is a good diagnostic tool used to ensure proper operation of the 

GNSS receiver and the Iridium transceiver. It can also be used to manage battery life by 

turning off tracking mode and strategically sending on-demand location reports. It can be 

considered as “manual tracking mode.” 

7.4 CHK-IN 

Use the Check-In [Chk-In] to send a quick message with a single, easily accessed 

button. When you press the Chk-In button, a second screen appears requesting 

confirmation. Once confirmed, the SHOUT ts sends out a reserved canned message code 

representing a Chk-In message. If the Texting/Inc GPS option is enabled, GNSS location is 

attached to the Chk-In message. Chk-In messages with GNSS location take longer to 

complete because the SHOUT ts has to acquire a GNSS fix first. 
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7.5 MAP 

The Map screen allows you to view locations received from other trackers. The 

locations are shown relative to your current position. Normally, north is aligned to 

the top of the screen; however, if the device is able to accurately determine the heading, 

the map rotates to orient to the direction of travel. 

Below the map is a list of the points from the map with labels to match the letter shown 

on the map. With the  icon, you can clear the map of points. The  icon allows you to 

scale the zoom of the map, ranging from 40 m to 20 km. There is also a Best Fit zoom, 

which scales the map to fit the points on the screen. The maximum zoom for this is limited 

to 5,000 km. 

 

Figure 24: Map 

You can select a point from the list to view information that is more detailed. From 

there, delete individual points by selecting pressing Delete. You can compose a message 

through the Compose Screen by selecting Compose. Pressing the back button reopens the 

list of points. 

7.6 WAYPTS 

Use the Waypoints [Waypts] menu to acquire, view, save, delete, or send a 

waypoint to a NOC. The SHOUT ts can save up to 1,000 waypoints in its circular 

memory. SatTerm can be used to retrieve waypoints saved on the SHOUT ts. 

A waypoint is a GNSS location that you want to identify and mark with a specific 

nametag for future reference.  
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1. Select New. The SHOUT ts immediately turns the GNSS receiver on to acquire a fix.  

2. Select one of the following options:  

a. Go back without further action. 

b. Reacquire a new GNSS fix. 

c. Label the point. 

d. Save the waypoint.  

3. Select the Label option to open a full keyboard to enter the waypoint label.  

4. Select Add to save the waypoint into the SHOUT ts’ nonvolatile memory for later 

retrieval.  

After saving a waypoint, you can also send it to a NOC server. The server differentiates 

waypoint reports from normal tracking reports by their short codes. 
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8 SETTINGS MENU 

Use the Settings menu to view and customize the SHOUT ts hardware settings. 

 

Figure 25: Settings Menu 

8.1 AUDIO 

Use the Audio option to change the frequency, tone, and mute setting of a variety 

of audio alerts including incoming messages, general error, geofences, and man 

down locator alerts. In addition to the individual settings, all audio can be muted through a 

single setting (except the locator alert). The  icon appears at the top of the screen if Mute 

All is on. Use Preview to test the audio volume and sound before selecting. 

8.2 BACKLIGHT 

Use the Backlight option to set the period of inactivity after which the SHOUT ts 

turns the Liquid-Crystal Display (LCD) backlight off. Set the backlight to Always On 

for nighttime use. 

8.3 CALIBRATE 

A resistive touchscreen drifts slowly over time and needs to be recalibrated 

occasionally. The Calibrate option allows you either to reset the calibration back to 

factory settings or to recalibrate specifically to the condition of the touchscreen. If the 

SHOUT ts is accidently recalibrated with erroneous settings and you are unable to use the 

touchscreen to recalibrate or reset to factory settings, with the SHOUT ts turned off, hold 
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the power button for ~7 seconds or until the reset calibration screen opens. DO NOT 

connect the SHOUT ts’ USB port to any device. 

8.4 CONTRAST 

Use the Contrast option to change the LCD brightness. Slide the contrast bar to 

the desired setting and press back to accept. 

8.5 FAVORITES 

Use the Favorites option to select any icon to appear at the bottom of the home 

screen. This allows quick and easy access to the most frequently used options. A 

maximum of four active favorite icons is allowed. The icons appear in the order selected. 

8.6 GPS 

The GPS menu provides access to the Position Format and Position Model options. 

Use Position Format to select one of four different GNSS position formats to be 

displayed on the LCD screen. Do not confuse this option with the Format option under 

Tracking, which defines the format of position report to be transmitted to a NOC. 

Use Position Model to formulate the static and dynamic characteristics of the GNSS 

receiver. By default, Portable model is used; this is suitable for most applications. However, 

for those requiring functionality at high altitudes, speeds, or accelerations, select an 

alternate model. 

 Portable (default setting): Suitable for most situations; for applications with low 

accelerations; maximum altitude of 12 km; maximum velocity of 310 m/sec; 

maximum vertical velocity of 50 m/sec; sanity check type: altitude and velocity; 

maximum position deviation: medium. 

 Stationary: Used in timing applications (antenna must be stationary) or other 

stationary applications; velocity is constrained to 0 m/s; zero dynamics assumed; 

maximum altitude of 9 km; maximum velocity of 10 m/sec; maximum vertical 

velocity of 6 m/sec; sanity check type: altitude and velocity; maximum position 

deviation: small. 

 Pedestrian: Applications with low acceleration and low speed, as a pedestrian 

would move; assuming low accelerations; maximum altitude of 9 km; maximum 

velocity of 30 m/sec; maximum vertical velocity of 20 m/sec; sanity check type: 

altitude and velocity; maximum position deviation: small. 
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 Automotive: Used for applications that can be compared with the dynamics of a 

passenger car; assuming low vertical acceleration; maximum altitude of 6 km; 

maximum velocity of 84 m/sec; maximum vertical velocity of 15 m/sec; sanity 

check type: altitude and velocity; maximum position deviation: medium. 

 Sea: Recommended for applications at sea; assuming zero vertical velocity; 

maximum altitude of 500 m; maximum velocity of 25 m/sec; maximum vertical 

velocity of 5 m/sec; sanity check type: altitude and velocity; maximum position 

deviation: medium. 

 Airborne < 1g: Used for applications that have to handle a higher dynamic range 

than a car and higher vertical accelerations; no 2D position fixes supported; 

maximum altitude of 50 km; maximum velocity of 100 m/sec; maximum vertical 

velocity of 100 m/sec; sanity check type: altitude; maximum position deviation: 

large. 

 Airborne < 2g: Recommended for typical airborne environment; no 2D position 

fixes supported; maximum altitude of 50 km; maximum velocity of 250 m/sec; 

maximum vertical velocity of 100 m/sec; sanity check type: altitude; maximum 

position deviation: large. 

 Airborne < 4g: Only recommended for an extreme dynamic environment; no 2D 

position fixes supported; maximum altitude of 50 km; maximum velocity of 500 

m/sec; maximum vertical velocity 100 m/sec; sanity check type: altitude; 

maximum position deviation: large. 

8.7 LANGUAGE 

Only English is available for this firmware version. 

8.8 LED 

The SHOUT ts has a status LED   at the bottom-left corner to indicate whether 

the device is in emergency mode, tracking mode, geofence tracking, mailbox check, or call 

out. Except for the emergency mode, the LED flashes once every five seconds when other 

modes are enabled and the device sleeps. The LED turns solid green when the emergency 

mode is enabled. You can turn off the LED for either of these two cases to save battery 

power using the LED option. 
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8.9 RESET 

The Reset option restores all setup parameters back to the manufacturer’s 

settings. When Reset is selected, a screen appears with the current settings and a 

confirmation message asks whether to reset these current settings back to the 

manufacturer’s default settings. 

8.10 SEARCH 

Use the Search option to set the search parameters for canned messages, contact 

list, and mailboxes. 

8.11 SECURITY 

Use the Security option to enable or disable the power-up PIN code and Access 

Control List PIN code and to set up the Access Control List. The PIN code can be up to 

a four-digit number. Use the Access Control List (ACL) to set which menu icons are visible. 

If a menu option is disabled in the ACL, it is also removed from the favorites. 

8.12 TIME/DATE 

Use the Time/Date option to select UTC time and date formats to be displayed on 

the LCD screen for all menus. The local time zone can also be set. 

8.13 INFO 

The Info option displays the model number, Iridium module’s International Mobile 

Equipment Identification (IMEI number), Iridium FCC ID, Iridium Industry Canada 

(IC) ID, ts’ firmware version, and ts’ bootloader version. 

8.14 USER INFO 

The User Info option displays user information entered using SatTerm software. 
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9 ADDITIONAL FEATURES 

9.1 EMERGENCY (911) BUTTON 

The Emergency 911 button  is located underneath a rotating guard at the back of the 

SHOUT ts. Use it at any time regardless of the tracking status (enabled or disabled) or 

power status (on or off). When pressed, the emergency LED  immediately turns solid 

green to indicate that the device is in emergency mode. The device then attempts to quickly 

send three consecutive reports. Because these reports are sent quickly, a GNSS fix may not 

be immediately available; however, the emergency indication flag will be set. After sending 

the first three emergency reports, the SHOUT ts reverts to the default emergency Time-

Between-Reports (TBR) of two minutes. The LED can be deactivated to extend the battery 

life by using the Settings > LED menu. If the LCD screen is on during emergency 

activation, the black bar across the top of the screen turns red. During emergency, a NOC 

can send an acknowledgement back to the SHOUT ts. 

 

Figure 26: Emergency Mode Display 

The status LED 
turns solid green 
under emergency 
mode. 

This bar turns 
from black to 
red under 
emergency 
mode. It turns 
back to black 

when the device 
is taken out of 
emergency 
mode. 
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9.2 STATUS LED 

There is one status LED at the bottom-left of the SHOUT ts. The LED turns solid green 

when the SHOUT ts is in emergency mode, which can be turned off to save power using the 

Settings > LED menu. During normal tracking, it flashes once every five seconds when the 

SHOUT ts sleeps. It can be turned off to save power using Settings > LED menu. 

9.3 TURNING OFF 

Turn off the SHOUT ts by holding the power On/Off   button for approximately two 

seconds. A power-down screen appears with a message indicating tracking and messaging 

will be completely turned off. The screen stays on for approximately ten seconds before 

turning off. Press Turn Off to turn off the SHOUT ts immediately, press Lock to go back to 

the power-up screen, or press Cancel to return to the previous screen. 
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APPENDIX A: PECOS MESSAGE STRUCTURE 

APPENDIX A-1: TRACKING 

The SHOUT ts can send position reports in PECOS Message Structure (PMS). PMS 

complies with the Blue Force Tracking Data Format Specification as defined in the 

document PECOS Message Definition Specification, 200907-001 Version 1.7 [1]. The SHOUT 

ts is shipped without PMS features activated and can only be enabled by NAL Research at 

the request of an authorized user. When PMS is enabled, the Format menu has an additional 

option called PECOS, as shown in Figure 27 below. 

 

Figure 27: PECOS Option in Format Menu 

APPENDIX A-2: BREVITY 

With PMS enabled, you have the option to select any one of sixteen brevity codes 

(0000 through 1111) to be included in the PMS tracking reports. These codes are 

represented by A(z), B, C(z), and D, and can be selected via the touchscreen. Each code 

lights up as a green dot inside the Brevity icon when selected. 

APPENDIX A-3: COMPOSE 

With PMS enabled, the Compose menu does not allow you to enter an email 

address from the keyboard. The address must be chosen from the contact list. 
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APPENDIX A-4: CONTACTS 

With PMS enabled, use the Contacts menu to enter and save a contact(s) via the 

keyboard. The contact(s) can only have two fields—Name and IMEI number. 

APPENDIX A-5: MAP 

While in PECOS mode, location update points are displayed in blue. There is also 

an option to add a contact by pressing Add Contact on the selected point. You can 

then enter a name and group for that contact. 

 

Figure 28: Add Contact to Map 
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APPENDIX B: UPGRADING THE FIRMWARE 

The SHOUT ts firmware can be upgraded using a computer connected to the USB port of 

the device. The device drivers support Windows XP, Windows Vista, and Windows 7.  

To upgrade the firmware: 

Run the NAL USB Firmware Loader program provided as part of the firmware download 

from the NAL Research website (https://www.nalresearch.com/support/documentation-

downloads/). 
 

 

Figure 29: Run Firmware Loader Program 

1. With a USB cable attached to a computer and the device, press Start Flash Mode 

as shown in Figure 29. 

2. Wait until it activates and then press the "…" button. 

Browse and select a valid NAL device BIN file.  

Note: NAL Research makes the BIN file available upon request. 
 

 

Figure 30: Load BIN File 

3. Once the BIN file is loaded, press Program as shown in Figure 30. 

4. Wait for the programming to complete. 

https://www.nalresearch.com/support/documentation-downloads/
https://www.nalresearch.com/support/documentation-downloads/
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5. A message box pops up, indicating the loading is complete. The new firmware is 

now loaded on the device. It may take a few moments for the memory to initialize 

after the upgrade. 
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APPENDIX C: POWER CONSUMPTION 

The SHOUT ts has an internal 1.95 A-Hr Li-ion rechargeable battery. When both the 

Iridium and GNSS antennas have a clear view of the sky and the battery is fully charged, 

the SHOUT ts is capable of sending more than 1,500 tracking reports with the following 

settings: (1) report rate of less than two hours, and (2) mailbox check rate and the report 

rate are the same. Blocked or partially blocked antennas force the SHOUT ts to retry 

multiple SBD transmissions for each report and, as a result, can significantly reduce the 

overall number of reporting cycles. 

The SHOUT ts saves valid ephemeris data after each 3D fix. The data is used to reduce 

acquisition time in the next reporting cycle from cold-start to hot-start. If the ephemeris 

data is older than two hours (time between reports is set for more than two hours), the 

GNSS receiver goes through cold-start each time it wakes up to send a report. As a result, 

the SHOUT ts configured for report rate of more than two hours can only send ~750 

tracking reports. 

Important: Data presented here are only estimates and are highly dependent on the 

operating environment and antenna type. Data are based on measurements made with 

multiple ts devices placed on the roof of NAL Research’s facility with no blockage. 

Each time the SHOUT ts wakes up to send a report, it has two minutes to acquire a 

GNSS fix and send an SBD message. Assuming the ephemeris data is valid (less than two 

hours old or time-between-reports is less than two hours); the GNSS receiver takes about 5 

seconds for a position fix drawing approximately 55 mA. The Iridium transceiver takes 

about 15 seconds to transmit an SBD message drawing an average current of 190 mA. The 

SHOUT ts circuit draws about 60 mA during a 20-second reporting cycle. The entire 

reporting cycle consumes ~1.12 mA-Hr of battery power. If the Iridium antenna is blocked 

or an overhead Iridium satellite is not available, the Iridium can potentially stay on for 

another 100 seconds in attempting to send a report. This results in additional consumption 

of 9.7 mA-Hr or 11 mA-Hr total. A missed report consumes ~8.5 times more power than a 

‘normal’ transmitted report. 
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APPENDIX D: DESIGN SPECIFICATIONS 

The design specifications for the SHOUT ts and SHOUT tw are identical, except where 

noted in the following sections. 

APPENDIX D-1: MECHANICAL SPECIFICATIONS 

Dimensions:  ...................................................SHOUT ts: 4.1” x 2.3” x 0.9” (104 mm x 

58 mm x 23 mm)  

SHOUT tw: 4.2” L x 2.4” W x 0.9” D (107 

mm x 61 mm x 23 mm) 

 

Weight: ..........................................................SHOUT ts: ~7.2 oz (204 grams) 

SHOUT tw: ~7.5 ounces (213 grams) 

Enclosure: Hard anodized aluminum 

housing/EMI shielding 

Connector:  .....................................................USB Micro-B 

Antennas: .......................................................GNSS and Iridium  

Key: ...............................................................One button power button 

Emergency: .....................................................Guarded button 

LED: ...............................................................One status LED 

Screen: ...........................................................3.0” TFT 400 x 240 pixels 

APPENDIX D-2: ELECTRICAL SPECIFICATIONS 

Main Input Voltage: ..........................................5.0 VDC 

Peak Current: ..................................................1.5 A @ 5.0 VDC 

Battery Type: ..................................................Lithium-ion 

Battery Capacity: .............................................1.95 A-Hr 

Charging Voltage: ............................................USB 1.0, USB 2.0 or 5VDC 

Rechargeable Cycles: ........................................500 times 

Power Consumption: ........................................See previous section 

APPENDIX D-3: IRIDIUM TRANSCEIVER 

Operating Frequency: .......................................1616.0 to 1626.5 MHz 

Duplexing Method: ...........................................TDD 

Multiplexing Method: ........................................TDMA/FDMA 

Link Margin Downlink: ......................................13 dB average (free space) 
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Link Margin Uplink: ..........................................7 dB average (free space) 

APPENDIX D-4: GNSS RECEIVER 

GNSS Receiver: ...............................................u-blox NEO-6Q 

Receiver Type: .................................................L1, C/A, 50-channel 

Update Rate: ...................................................4 Hz 

Accuracy: ........................................................2.5 m CEP (position) 

2.0 m CEP (SBAS) 

Acquisition: .....................................................29 seconds cold-start 

29 seconds warm-start 

<1 second hot-start 

Sensitivity: ......................................................–160 dBm (tracking) 

–160 dBm (reacquisition) 

–147 dBm (cold-start) 

APPENDIX D-5: ENVIRONMENTAL SPECIFICATIONS 

(ELECTRONICS) 

Operating Temperature:....................................–20oC to +60oC (–4oF to +140oF) 

Operating Humidity: .........................................≤ 75% RH 

Storage Temperature: ......................................–20oC to +60oC (–4oF to +140oF) 

Storage Humidity: ............................................≤ 93% RH 

 

APPENDIX D-6: ENVIRONMENTAL SPECIFICATIONS 

(BATTERY) 

Operating Temperature:....................................–20oC to +60oC (–4oF to +140oF) 

Operating Humidity: .........................................≤ 90% RH 

Storage Temperature: ......................................–20oC to +60oC (–4oF to +140oF) 

Storage Humidity: ............................................≤ 95% RH 

Charge Temperature: .......................................0oC to +45oC (32oF to +113oF) 

 

APPENDIX D-7: ENVIRONMENTAL SPECIFICATIONS (LCD) 

Operating Temperature:....................................–20oC to +55oC (–4oF to +131oF) 

Operating Humidity Range: ...............................≤ 90% RH 
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Storage Temperature Range: .............................–20oC to +85oC (–4oF to +185oF) 

Storage Humidity Range: ..................................≤ 95% RH 
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APPENDIX E: STANDARDS COMPLIANCE 

The SHOUT ts has an internal Iridium 9602 transceiver module. The 9602 is tested to 

the regulatory and technical certifications shown below. It is assigned to the FCC Identifier 

Q639602. 

 

 

 

Table 2: Standards Compliance 

Regulatory 

Approvals 

Radio Tests EMC Tests Mechanical/ 

Electrical Tests 

CE ETSI EN 301 441 

V1.1.1 (2000-05) 

ETSI EN 301 489-1 V1.4.1 

(2002-08) 

ETSI EN 301 489-20 V1.2.1 

(2002-11) 

EN60950-1:2001 

Part 1 

UL60950-1 Part 1 

FCC FCC CFR47 Parts 2, 

15, and 25 

EN61000-4-2: 1995/A2:2001 

Part 4.2 

 

IC Industry Canada 

RSS170 Issue 1, Rev 

1, November 6, 1999 

EN61000-4-3: 2002 Part 4.3 

EN61000-4-4: 

1995/A1:2001/A2:2001 Part 

4.4 

EN61000-4-6: 1996/A1: 

2001 Part 4.6 

EN55022: 1998/A1: 

2000/A2: 2003 
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APPENDIX F: EXPORT COMPLIANCE 

The SHOUT sp is controlled by the export laws and regulations of the United States of 

America (USA). It is the policy of NAL Research to fully comply with all U.S. export and 

economic sanction laws and regulations. The export of NAL Research products, services, 

hardware, software, and technology must be made only in accordance with the laws, 

regulations, and licensing requirements of the U.S. Government. NAL Research customers 

must also comply with these laws and regulations. Failure to comply can result in the 

imposition of fines and penalties, the loss of export privileges, and termination of your 

contractual agreements with NAL Research. 

The export and re-export of NAL Research products and services are subject to 

regulation by the Export Administration Regulations (15 CFR 730-744), as administered by 

the U.S. Department of Commerce, Bureau of Industry and Security (“BIS”). See: 

https://www.bis.doc.gov/index.php/regulations/export-administration-regulations-ear for 

further information on BIS and the Export Administration Regulations (EAR). Additional 

export restrictions are administered by the U.S. Department of the Treasury’s Office of 

Foreign Asset Controls (“OFAC”). See: http://www.ustreas.gov/ofac for further information 

on OFAC and its requirements. 

 

https://www.bis.doc.gov/index.php/regulations/export-administration-regulations-ear
http://www.ustreas.gov/ofac


  SHOUT ts/tw User Guide Version D 

Document Number: 451-92854-001D 64 of 65 

 

Figure 31: SHOUT ts Mechanical Drawing 
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Figure 32: SHOUT tw Mechanical Drawing 
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